
   

8.2.1 Release Notes 
The following notes describe changes on the 8.2.1 CD. Please 
read them carefully before you use your new software. The 
following applications have changed: 

! Accounts Payable 

! Accounts Payable�Australian 

! Address Book 

! Cash Management 

! General Ledger 

! ODBC 

! Payroll 

! Payroll�Australian 

! Payroll�Canadian 

! Report Designer 

For information on previous releases, please refer to the 
following documents: 

! Release Notes for the 8.2.0 CD 

! Release Notes for the 8.1.1 CD 

! Release Notes for the 8.1.0 CD 

! Release Notes for the 8.0.0 CD 
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Upgrade to the 8.2.1 CD 
If you have a 7.x.x or 8.x.x CD, you can upgrade directly to 
the 8.2.1 CD. 

If you have a Gold Collection 5.4.x CD and you use the 
Standard Edition, you must upgrade to a 7.5.x or 7.6.x CD 
before you upgrade to the 8.2.1 CD. 

Upgrade Accounting and Management Data Before 
You Upgrade Estimating Data 

The first time that you install an Accounting and 
Management Products 8.x.x CD and an Estimating Products 
6.5.x CD, be sure to upgrade your accounting and 
management data files before you upgrade your estimating 
data files. This ensures that the upgrade program does not 
duplicate contact information in Address Book. 

If you generate duplicate contact information, you can 
manually delete the duplicates, but this could take a 
significant amount of time, depending on the size of your 
contact database. 

Upgrade Data Files After You Upgrade to 8.2.1 

If you use an 8.2.0 CD, upgrade Payroll data files after you 
install the 8.2.1 CD. 

If you use an 8.1.0 or 8.1.1 CD, upgrade data files for the 
following applications after you install the 8.2.1 CD: 

! Accounts Payable 

! Address Book 

! Cash Management 

! Inventory 

! Payroll 

! Project Management 

! Purchasing 

If you use an 8.0.0 or 8.0.1 CD, upgrade data files for the 
following applications after you install the 8.2.1 CD: 

! Accounts Payable 

! Address Book 

! Cash Management 

! Inventory 

! Job Cost 

! Payroll 

! Project Management 

! Property Management 

! Purchasing 

! Service Management 

If you use a 7.x.x CD, upgrade all data files after you install 
the 8.2.1 CD. 
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Accounts Payable 8.2.6 

Fixes 

Change Invoices 

Multiple operators can use Change Invoices at the same 
time. In earlier versions, only one operator at a time could 
use Change Invoices. 

Invoice Entry 

A Project Management commitment must be released to 
accounting before you can enter the commitment on an 
Accounts Payable invoice. 
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Accounts Payable 8.2.6�
Australian 

Fixes 

Change Invoices 

Multiple operators can use Change Invoices at the same 
time. In earlier versions, only one operator at a time could 
use Change Invoices. 

Invoice Entry 

A Project Management commitment must be released to 
accounting before you can enter the commitment on an 
invoice. 
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Address Book 8.2.9 

Compatibility 
To make existing Accounts Payable and Accounts Receivable 
records available in Address Book after installation, in TS 
Main, select Tools > Upgrade Files. The upgrade process 
creates Address Book contact records from Accounts 
Receivable and Accounts Payable in the Master.abm. 

If you use both accounting and estimating products, upgrade 
accounting data files before using the Estimating wizard (see 
below). If you upgrade Estimating first, you will not lose 
contact information, but you will have to resolve duplicates 
by hand. This could take a significant amount of time, 
depending on the size of your contact database. You need to 
upgrade accounting first only with your initial installation of 
Address Book.  

Estimating Tools provides a wizard to upgrade or convert 
your existing subcontractor records from various Timberline 
Estimating databases into Address Book contacts. The wizard 
also produces reports to help you resolve conflicts and 
duplicates in data. For more information see the Help topic 
"Integrating subcontractors into Address Book" on the 
Contents tab in Estimating Tools Help.  

For detailed information on upgrading to AB, see Upgrade to 
Address Book.pdf. You can access this file in the following 
ways: 

! When you install Timberline Office, in the Timberline install 
window, click Browse All Documents on CD in bottom 
left corner. 

! After you install the software, from TS Main select Help > 
Release Notes. Select the Documents folder and browse 
to Upgrade to Address Book.pdf.  

New Features 
You can now enter an extension to the business telephone 
number on the Person Setup window. 

Fixes 
You can now add new person contacts while creating a 
company and add a new company while creating a person 
contact. This functionality is available in Estimating, Buyout, 
Accounts Receivable, Accounts Payable, Project 
Management, and Address Book. 
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Cash Management 8.2.22 

New Features 

Residential Management Interface 

Cash Management interfaces with Residential Management. 
You can automatically send deposit, adjustment, and NSF 
information from Residential Management to Cash 
Management. You must select the Residential Management 
check box on the bank account (Setup > Bank Accounts > 
GL Cash Account tab). Residential Management 
transactions use the general cash account. 
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General Ledger 8.2.1 

New Features 

Import Transactions 

You can import third-party transaction batches into General 
Ledger. See �from a third party� under �import transactions� 
on the Index tab in General Ledger Help. You must reset up 
any existing macros that include the Import Transactions 
task. 

Fixes 
Enhancements to Import Transactions may impact any 
macros you currently use. You must reset up any existing 
macros that include the Import Transactions task. 
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ODBC 8.0.32.204 

Compatibility 

IMPORTANT: Currently only Microsoft® Office 97, 2000, 
and 2002 (Access, Word, and Excel) are tested for 
compatibility with the Timberline ODBC driver. Timberline 
does not test for compatibility with any other products, 
including Microsoft Visual Basic for Applications (VBA), 
Microsoft ActiveX Data Objects (ADO), and Microsoft Data 
Access Objects (DAO). Although you may find success 
using another product, Timberline technical support can 
address only those issues and problems relating to the 
use of Microsoft Office (Access, Word, and Excel) to 
access data with the Timberline ODBC driver. 

For this release, Timberline tested ODBC compatibility with 
Office 97 on Windows 98 and NT 4. Timberline tested ODBC 
compatibility with Office 2000 on Windows ME and Windows 
2000. Timberline tested ODBC compatibility with Office 2002 
on Windows XP. 

Data Files 

The TS-ODBC driver is compatible with Timberline® Office 
data files. When you create Timberline data sources using 
ODBC Administrator 3.0, Microsoft Access, or Microsoft 
Query 8.0, note the items below. You can also read this 
information in the TS-ODBC Help topic �About creating 
Timberline data sources with ODBC Administrator v. 3.0 and 
MS Office.� 

! ODBC Administrator 3.0 and later allows a new data source 
to be created as a user data source name (DSN), a system 
DSN, or a file DSN. When you create a Timberline data 
source, you must create it as either a user or system DSN. 

A corresponding file DSN is created automatically when 
you set up a user or system DSN. 

! Microsoft Access allows a new data source to be created as 
a machine data source or a file data source. When you 
create a Timberline data source, you must create it as a 
machine data Source. A corresponding file data source is 
created automatically when you set up a machine data 
source. 

! Microsoft Query allows a new data source to be created 
only as a file data source. timberline data sources created 
from within Microsoft Query 8.0 do not provide access to 
Timberline data from Microsoft Query or any other 
application. Create new Timberline data sources from 
within the ODBC Administrator (see first bulleted item in 
this section). If existing Timberline data sources do not 
appear for selection within Microsoft Query, select the data 
source from within the ODBC Administrator. In the 
Timberline Data ODBC Setup window, click [OK]. A new 
file DSN entry generates automatically and is available for 
selection from within Microsoft Query. 

New Features 

Enhanced Help Topic 

ODBC 8.0.32.204 contains the following enhanced topic: Set 
up Driver Options. 

Shorten Field and Table Names Option 

Before ODBC 8.0.3, Timberline�s ODBC driver shortened 
table names longer than 36 characters and shortened field 
names longer than 25 characters. You can now create data 
source names (DSNs) that are compatible with reports you 
designed for versions of the software earlier than Accounting 
and Management Products 8.0.0 and Estimating Products 6.5 
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or compatible with reports you designed for Accounting and 
Management Products 8.0 and later or Estimating Products 
6.5 and later. See "Set up driver options" in the Help file for 
more information. 

Fixes 

Windows 98 and Windows Me 

In ODBC 8.0.32.130 (8.1.0 CD) only, if you used Windows 
98 or Windows Me to access accounting or estimating data 
through ODBC, the value �#deleted� could incorrectly 
appear. No data corruption occurred. ODBC 8.0.32.140 fixes 
this issue. 

SQL Operators and Property Management 

In 8.0.03 (8.0.0 CD) and ODBC 8.0.32.130 (8.1.0 CD), if you 
used the SQL operators �IN,� �BETWEEN,� �>=,� or �<=� to 
access date records in Property Management data, ODBC 
could omit records if the date equals the start date. ODBC 
8.0.32.204 fixes this issue. 

Database Access With a Program 

In ODBC 8.0.03 (8.0.0 CD) and ODBC 8.0.32.130 (8.1.0 
CD), if you wrote a custom program to access data, ODBC 
could return an error if the path to the data source exceeded 
68 characters. ODBC 8.0.32.204 fixes this issue. 

Job Cost Cost Code Custom and Job Cost Job 
Custom Fields 

In the previous version, if you tried to add records to the Job 
Cost Cost Code Custom or Job Cost Job Custom fields, 
ODBC could return the following error: �ODBC--insert on a 
linked table 'Master_JCM_Cost_code_Custom_Fields' failed. 

[Timberline][ODBC][DLL] I/O Error. Pervasive Status code 
46.  Access to the requested file is denied.� ODBC 8.0.32.204 
fixes this issue. 

Project Management Spec Section Description 
Field 

In the previous version, if you tried to change the 
Description field on the Project Management Spec. Section 
record, ODBC could return the following error: �Access 
denied.� ODBC 8.0.32.204 fixes this issue. 

Special Instructions 
This section includes special instructions regarding certain 
front-end applications and the TS-ODBC driver. Please read 
this section before you use the new version of software.  

Data Filenames in Microsoft Access and Microsoft 
Query  

Microsoft Access and Microsoft Query place limits on the 
length of table names. To determine the length of a table 
name as seen from an application, count each character in 
the table name as it is displayed in the application. Count 
each underscore character ("_") twice. If the number of 
characters is over 63 for Microsoft Access or over 65 for 
Microsoft Query, the table name is too long. Table names 
that exceed the allowed maximum number of characters will 
be inaccessible from Access or Query. If you find any table 
names that are too long, rename the data file that contains 
the table to a shorter name. 
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Invalid Entry Error Associated With Microsoft 
Query 

If you try to create Timberline records using the Query 
window in Microsoft Query, you may receive the message 
"Invalid Entry." This message appears if the TS-ODBC 
driver detects that a field in the record you are trying to 
create contains either an invalid entry or no entry. To resolve 
this problem, create your Timberline records from Query 
using an SQL statement. Refer to your Microsoft Query 
documentation for more information about creating SQL 
statements. 

Microsoft Patches That Affect ODBC 

Microsoft frequently releases patches for its Office products 
that could affect how Timberline's ODBC driver works. For 
more information about Microsoft patches, refer to the Web 
site http://officeupdate.microsoft.com. 

Updating ODBC Links When Column or Field 
Names Change 

If any column headers or field names change in an 
application, remember to update the SQL statements that 
relate to those columns or fields. For example, if you change 
a field name using Custom Descriptions (File > Company 
or Data Folder Settings), you also need to update all ODBC 
links that use that field. 
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Payroll 8.2.6 

New Features 

Enhanced Help Topic 

Washington State Quarterly Reporting: Added new 
information about importing the magnetic media file into the 
state reporting system. 

Government Reporting (Reports Menu > 
Government Reporting) 

Three new reports are available on the Government 
Reporting menu: 

! Federal Form 941 

! Federal Form 941 � Schedule B 

! Wisconsin Quarterly Form UC-7823 

If you installed the 8.1.0 CD (Year-end), you may want to 
remove the Utah Quarterly Wage List from the Government 
Reporting submenu. UT Quarterly Form 3H is the same 
report but the title more clearly identifies the form. 

NOTE: If you use named files, reports created using 
Crystal Reports® may ask you to enter the name of the 
file more than once. This is an indication that two or more 
different records from the same file are being used in the 
report. 

ODBC Enabled 

The following fields on the Employee record are now ODBC 
enabled: 

! SM Employee 

! Use Employee Work State 

! 3rd party sick 

The following fields on the Employee state record are now 
ODBC enabled: 

! Employee 

! Employee state 

! Filing status 

! Personal Exemptions 

! Spouse SSN 

! Misc Tax Code 

! Misc Tax Code 2 

! Misc Tax Code 3 

Fixes 

Change Posted Time (Tasks Menu, ChangeTime 
Entries) 

Payroll no longer exits unexpectedly when you use a time 
entry view without units in Change Posted Time. 

Change Unposted Time (Tasks Menu, Change Time 
Entries) 

Unit and dollar totals now display correctly on the window 
when a processed check is changed. Previously, incorrect 
totals were displayed on the window after changes were 
made to a check that had already been processed. 

Enter Checks (Tasks Menu) 

In some cases, if the pay rate was missing from an employee 
pay record and the units were entered during an Enter 



Release Notes�Payroll 8.2.6 12 of 19 8.2.1 CD 

Checks session, processed, then overridden during the same 
session, the rate would prefill based on the same pay ID on 
the next employee's pay record. This has been corrected. 

If a worker's compensation tax amount is overridden, the 
change is now correctly applied to the check time records. 
Previously, overriding a Washington Workers� Compensation 
tax amount (WAWC_E) resulted in an incorrect tax amount 
on the check time record. 

Enter Time (Tasks Menu) 

A local tax group no longer prefills from a previous job when 
the current job contains no local tax group. Previously the 
local tax group field was prefilled from the previous line entry 
when: 

! Local was included in the timesheet view 

! There was no local in the Work Local field in the Payroll 
master file for the employee. 

! During time entry, a job with no local was entered 
following a job with a local. 

! The employee on the current time entry was the same as 
on the previous time entry. 

An employee's work state and local now prefills during Enter 
Time only for employees with Use employee work 
state/local selected on the Entry Info tab in Employee 
Setup. Previously, the work state and local sometimes 
prefilled incorrectly from the preceding employee for an 
employee without Use employee work state/local 
selected. 

The union local now prefills for jobs set up in a Job Local 
table only. Previously, if a Job Local table was not being 
accessed during time entry, the union local from the job on 
the preceding line of time was included in the entry in error. 

Print Quarterly Reports (Tasks Menu) 

SUI Hours 

Previously, if you entered more than one line of time for a 
salaried employee and cleared the salaried amounts in order 
to automatically prorate the earnings across all time entries, 
the SUI hours were calculated incorrectly. For states whose 
quarterly form includes the QTD SUI hours (MN, WA, WY, OR 
and possibly some user defined reports), the SUI hours may 
have been incorrect. This has been corrected. 

Pennsylvania 

Changes were made to quarterly magnetic media for 
compliance with state requirements. These changes affect 
the way the employee name is written to the magnetic media 
file and other minor issues. 

PR Settings (File Menu) 

GL Entry Settings 

Payroll no longer exits unexpectedly when you click [List] 
and select a GL account number that is 25 characters long. 
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Payroll 8.2.6�Australian 

New Features 

Formulas (Tools Menu) 

The following formulas were added to the Payroll formula file 
for use on pay Ids that track Annual Leave, Long Service 
Leave (LSL), Rostered Day Off (RDO) and sick days. 

! PR Annual Leave Loading 

! PR Annual Leave Provision 

! PR Annual Leave Taken 

! PR Employee Regular Rate 

! PR LSL Accrual 

! PR LSL Provision 

! PR LSL Taken 

! PR RDO Dollar Deduction 

! PR RDO Provision 

! PR RDO Taken 

! PR Sick Days per Year 

! PR Sick Leave Accrual 

! PR Sick Leave Provision 

! PR Sick Leave Taken 

! PR Sick Lve Acc First Yr 

! PR Years Employed 

New help topics are available to explain the new formulas 
and their use. 

! Annual Leave Hours and Pay Accrual 

! Long Service Leave Hours and Pay Accrual 

! Pay Ids for Annual Leave Hours 

! Pay Ids for Long Service Leave Accrual 

! Pay IDs used in sick leave pay accrual formulas 

! PR Annual Leave Loading 

! PR Annual Leave Provision 

! PR Annual Leave Provision-self adjusting 

! PR Annual Leave Taken 

! PR Employee Regular Rate 

! PR LSL Accrual formula 

! PR LSL Provision formula 

! PR LSL Taken formula 

! PR RDO Dollar Deduction 

! PR RDO Provision 

! PR RDO Taken 

! PR Sick Days per Year 

! PR Sick Leave Accrual 

! PR Sick Leave First Year 

! PR Sick Leave Provision 

! PR Sick Leave Provision-self adjusting 

! PR Sick Leave Taken 

! PR Years Employed 

! PR-LSL Provision-self adjusting formula 

! Reports available for sick leave reporting 

! Reports available for tracking Annual Leave 

! Reports available for tracking Long Service Leave 

! Reports available for tracking Rostered Day Off 
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! Rostered Day Off Hours & Pay Accrual 

! Sick Leave Hours and Pay Accrual 

Reports (Reports Menu) 

The following reports were added to the Registers 
submenu. 

! Pay ID Totals 

! Deduction ID Totals 

! Fringe ID Totals 

! Employee Totals by Fringe 

! Payroll Totals by Paygroup 

The following reports were added to the Pay Period 
Processing submenu. 

! Cheque Register 

! Job Labour Hours 

! Weekly Job Labour 

! Back Pay Calculation 

The following reports were added to the Lists submenu. 

! Employee Birthday Calendar 

! Employee Anniversary Calendar 

The following reports were added to the Setup submenu. 

! Employee Defaults 

! Departments 

! Unions 

! Classes 

Fixes 

Change Posted Time (Tasks Menu, Change Time 
Entries) 

Payroll no longer exits unexpectedly when you use a time 
entry view without units in Change Posted Time. 

Change Unposted Time (Tasks Menu, Change Time 
Entries) 

The correct totals now appear on the window after the 
cheque is changed. Previously, incorrect totals appeared on 
the window after changes were made to a cheque that had 
already been processed. 

Enter Cheques (Tasks Menu) 

In some cases, if the pay rate was missing from an employee 
pay record and the units were entered during an Enter 
Checks session, processed and subsequently overridden 
during the same session, the rate would prefill based on the 
same pay ID on the next employee's pay record. 

Enter Time (Tasks Menu) 

An employee's work state now prefills during Enter Time 
only for employees with Use employee work state selected 
on the Entry Info tab in Employee Setup. Previously, the 
work state and local sometimes prefilled incorrectly from the 
preceding employee for an employee without Use employee 
work state selected. 

The union local now only prefills for jobs set up in a Job 
Local table. Previously, if a Job Local table was being 
accessed during time entry and a job was not set up in the 
table, the union local from the  job on the preceding line of 
time was included in the entry in error. 
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Formulas (Tools Menu) 

The following formulas were renamed PR ZACFLXACC, PR 
ZACFLXACU, etc. These formulas were replaced by the new 
formulas listed in the Formula topic under Enhancements. 

If you would like to continue to use any of these formulas, 
copy the "Z" formula to public formulas. These "Z" formulas 
will be removed from the Payroll formula file in a future 
release. 

! PR ACFLXACC 

! PR ACFLXACU 

! PR ACFLXACV 

! PR ACHOLACC 

! PR ACHOLACU 

! PR ACHOLACV 

! PR ACHOLAMT 

! PR ACHOLENC 

! PR ACHOLENL 

! PR ACHOLENT 

! PR ACHOLENU 

! PR ACHOLEUS 

! PR ACLSLACC 

! PR ACLSLACU 

! PR ACLSLACV 

! PR ACRDOACC 

! PR ACRDOACU 

! PR ACRDOACV 

! PR ACRDOAMT 

! PR ACSICACC 

! PR ACSICACU 

! PR ACSICACV 

! PR ACSICAMT 

! PR Annual Sick Accrual 

! PR Employ Mast Accrl Rate 

! PR Employ Mast Pay Rate 

! PR Hours Accrual 

! PR PRPAYRAT 

ODBC Enabled 

The following fields on the Employee record are now ODBC 
enabled: 

! SM Employee 

! Use Employee Work State 

! 3rd party sick 

The following fields on the Employee state record are now 
ODBC enabled: 

! Employee 

! Employee state 

! Tax scale 

! Personal Exemptions 

! Misc Tax Code 

! Misc Tax Code 2 

PR Settings (File Menu) 

GL Settings 

Payroll no longer exits unexpectedly when you click on [List] 
and select a GL account number that is 25 characters long. 
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Journal Options 

The names of the Payroll journal designs were changed to: 

! PR Cheque Journal (T) 

! PR EQ Detail Journal (T) 

! PR Time Journal (T) 

To change the journal used by Enter Time, Enter Checks, 
Change Posted Time, and Change Unposted Time, select 
File > PR Settings. Click on [Journal Options]. Enter the 
name of the journal you wish to use. To select from a list of 
the reports in the Reports folder, click [�]. 

Reports (Reports Menu) 

The following reports have been renamed and updated to 
better reflect Australian payroll usage. You may want to 
remove any of the old reports that you do not use from the 
Reports menu. 

These reports are on the Registers submenu. 
 

Old Report Name New Report Name 

Burden Register On Cost Register 

Leave Accrual Summary Leave Available Summary 

These reports are on the Pay Processing submenu. 
 

Old Report Name New Report Name 

Payslips/Cheques  Payslips

Coin Analysis Report Coin Analysis 

 

These reports are on the Tax Preparation submenu. 
 

Old Report Name New Report Name 

PAYE Tax Payable Monthly PAYG Tax 

State Payroll Tax Monthly State Tax 

These reports are on the Reconciliation submenu. 
 

Old Report Name New Report Name 

Burden by Debit Account On Cost by Debit Account 

Labor Costs by Account_Job Labour Costs by 
Account_Job 

These reports are on the Employee Totals submenu. 
 

Old Report Name New Report Name 

Employee Holiday Leave 
Accrual 

Annual Leave Accrual 

Holiday Hours Taken by Date Annual Leave History 

The following reports were moved from the Lists submenu 
to the Setup submenu. 

! Employee Master Detail 

! Rate Tables 

! Pay Groups 
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Payroll 8.2.6�Canadian 

New Features 

ODBC Enabled 

The following fields on the Employee record are now ODBC 
enabled: 

! SM Employee 

! Use Employee Work State 

! 3rd party sick 

The following fields on the Employee state record are now 
ODBC enabled: 

• Employee 

! Employee state 

! Filing status 

! Personal Exemptions 

! Spouse SSN 

! Misc Tax Code 

! Misc Tax Code 2 

! Misc Tax Code 3 

Fixes 

Change Posted Time (Tasks Menu, Change Time 
Entries) 

Payroll no longer exits unexpectedly when you use a time 
entry view without units in Change Unposted Time. 

Change Unposted Time (Tasks Menu) 

The correct totals now appear on the window after the 
cheque is changed. Previously, incorrect totals appeared on 
the window after changes were made to the cheque that had 
already been processed. 

Enter Cheques (Tasks Menu) 

In some cases, if the pay rate was missing from an employee 
pay record and the units were entered during an Enter 
Cheques session, processed then subsequently overridden 
during the same session, the rate would prefill based on the 
same pay ID on the next employee's pay record. 

Enter Time (Tasks Menu) 

An employee's  work province now prefills during Enter 
Time only for employees with Use employee work 
province selected on the Entry Info tab in Employee 
Setup. Previously, the work province sometimes prefilled 
incorrectly from the preceding employee for an employee 
without Use employee work province selected. 

The union local now only prefills for jobs set up in a Job 
Local table. Previously, if a Job Local table was being 
accessed during time entry and a job was not set up in the 
table, the union local from the  job on the preceding line of 
time was  included in the entry in error. 

Print ROE (Tasks Menu) 

Employee Address Line 2 now prints on the Report on 
Earnings (ROE). 

Province Code (Setup Menu, Taxes, Tax Groups) 

The code for Newfoundland and Labrador has been changed 
to NL from NF. The tax ID is now NLTAX. NL is the province 
designation that is required for T4 reporting for 2003. 
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PR Settings (File Menu) 

GL Settings 

Payroll no longer exits unexpectedly when you click on [List] 
and select a GL account number that is 25 characters long. 
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Report Designer 8.2.7 

New Features 

New Help Topics 

The following topics were added for the Project Management 
functions: 

! PJ Job Contract by Role function 

! PJ Last Job Used function 
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